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William W. Iversen passed 

away on April 29, 2026, 

in Aurora, Colorado. 

Bill was my partner in 

founding Ortho2, and he 

had a profound impact on 

my life as well as on the 

entire Ortho2 family.

In 1981, Bill wanted 

a better way to track 

patient information, 
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accounts receivable, and treatment criteria. With his input, I 

programmed a highly customized system for his office using 

a Wang minicomputer.

A few months later, Bill suggested that we could offer the 

system to other orthodontists. It was a great idea with a 

profound impact. I developed a more generalized version 

for the newly emerging personal computer market, and we 

sold our first system in December 1982.

In 1986, Bill moved to Colorado and sold much of his 

company interest to Bob Scholz, Larry Stone, and Sue 

Matlof. Each of these individuals impacted the company’s 

ongoing success, but Bill’s role remains an essential part of 

our story.

Here are just a few memories of Bill from the early years:

•	 One of the first times I was in his office, he said he 

needed to make a quick call. After dialing, he spoke a 

few words into the phone, then shouted, “NO!” and 

hung up. Startled, I asked him what had happened. 

“She asked if she could put me on hold,” he said. Bill 

was not always a patient man.

•	 On a return flight after an exhausting meeting where 

we had exhibited our early system, the familiar “bong, 

bong” came over the speakers. Without hesitation, and 

for reasons known only to him, Bill loudly announced, 

“Everybody dance!” We laughed and laughed. To this 

day, whenever I hear those sounds on a flight, I think of 

Bill.

•	 One evening, while grilling a meal for us to enjoy, I 

noticed him sprinkling something on the burgers. It was 

garlic salt, it was wonderful, and I’ve used it ever since.

•	 An avid golfer, Bill was once asked how often he played. 

His answer: “I try to limit it to once a day.” Bill was an 

excellent and enthusiastic golfer.

I will always be grateful for Bill’s contributions to Ortho2 and 

for the impact he had on the course of my life. I am deeply 

saddened to say this final goodbye. 
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Dan Sargent, Ortho2 Senior Advisor

Canadian Association of Orthodontists	 September 25–26, 2026

Western Orthodontic Conference	 October 2-4, 2026

Southern Society of Orthodontists and 
Midwestern Society of Orthodontists	 October 15–17, 2026

Mother of Pearls Conference	 November 6-7, 2026

Northeastern Society of Orthodontists	 November 6-7, 2026

Visit Us at  
These Fall 
Meetings

2026 AAO Recap
Thank you to everyone who stopped by our booth at the AAO! We 
would like to thank the following team members who worked hard in 
the Ortho2 booth at the AAO and contributed to our success!

Diane Julius – Feldman Orthodontics
Jodi Miller – Quintero Orthodontics
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E dge Cloud 8.0 has been released to all customers! 

This article will highlight and explain some of the more 

common features in the update. View the full release notes 

at help.ortho2.com > Release Notes.

Patient Tracker and Light Bar
We heard from many users that they wanted more 

information in the Light Bar. With the 8.0 update, the Light 

Bar now shows the time the appointment will take based on 

its length and the 

time the patient 

was seated. For 

example, if an hour-

long appointment 

was scheduled and 

a patient was seated 

eight minutes 

late, you will see 

this as two times 

at the bottom of 

the appointment. 

This information 

supplements the 

start and end 

times seen on the 

Scheduler.

You can customize some components of the Light Bar, 

including:

•	 Picking a chair (which is required for Doctor is Needed 

shortcuts)

•	 Changing the information style and selected office 

(which is required for new templates starting with Edge 

Cloud 8.0)

•	 The header content

•	 How long until Waiting moves over to the next color 

•	 The timer counting up from the start instead of down to 

the end

•	 Toggling information like the patient’s name, 

appointment information, and timing-related 

information

To change these settings, click the wrench icon in the top 

right corner of the Light Bar. Note that these settings are 

machine-specific. Once you have chosen your settings, be 

sure to refresh the Light Bar by clicking the refresh icon 

under the wrench icon.

Along with these updates to the Light Bar, we have heard 

your concerns about the reduced visibility that came with 

the update. Our team is actively working on a new version of 

the Light Bar that will deliver both the expanded data points 

and the improved visibility you are asking for.

Doctor Time
Doctor time now supports partial minutes, allowing for more 

precise scheduling and time allocation. This can be set up 

in the redesigned Procedure editor. Simply define when 

the doctor is expected to be chairside and how long they 

are needed. These definitions show up in the Light Bar as a 

range and a solid color to visually show you when the doctor 

is expected chairside.

Global Payments Integration
When creating a payment on file with Global Payments, you 

can now enter the CVV, address line, and postal code. These 

enhancements help improve transaction security, reduce the 

risk of fraudulent activity, can contribute to higher approval 

Joe Randazzo is an Ortho2 Advanced Support Tech and Trainer with a 
background in software engineering and a healthy-ish obsession with 
technology. While hands are off the keyboard, he frequents karaoke 
venues, yaps about his electric compact car, and performs culinary 
crimes currently featuring Vegemite and textured vegetable protein.

Joe Randazzo

Contact Info: ortho2support@ortho2.com • 800.346.4504

Edge Cloud 8.0 Feature Review

rates, and help lower fees. 

Canadian Electronic Insurance
Canadian users can now submit electronic insurance 

through CDANet/ITRANS. To get started, contact the 

Implementation Team at 800.809.0277 or implementation@

ortho2.com. After onboarding and configuration with our 

Implementation Team, you will see a new User Option to 

enable Canadian electronic insurance per machine: Home > 

User Options > Insurance. From there, if the configuration 

of CDANet and the appropriate bridge on that computer 

are set up, claims can be submitted. Submission errors 

report back to Edge Cloud, and can include things like if 

the company does not support the code per ITRANS, or if 

identifying information required for submission is missing, or 

if some configuration in Edge Cloud needs correcting.

Invisalign/ClinCheck Integration
The integration with Invisalign has been overhauled, with 

the main change being how future updates will occur. Any 

future updates to either Invisalign or Chrome will be able to 

be made behind the scenes and won’t require an update on 

your end. 

If you are still having issues accessing Invisalign after 

updating to 8.0, check some of these common items:

•	 Update your password to be simpler with fewer special 

characters

•	 Ensure the credentials have “Doctor Login” level access 

to Invisalign

•	 Test possible credential issues with the Doctor Login 

site for Invisalign, then have a software administrator 

input the credentials under Home > Editors > System 

Integrations > Invisalign

•	 For multi-practice databases, input the credentials 

under Home > User Options > Integrations > 

Invisalign

Call the Software Support Team if these steps don’t resolve 

the issue.

Edge Mobile
Edge Mobile is back in both the Apple App and Google 

Play stores! The Edge Mobile app is a simple and great 

way to get a quick look at your patients, professionals, 

appointments, stacks, and other chart metrics at a glance 

from your phone. 
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Cathy is meticulous, detail-
oriented, and she will educate 
you on how to run your business; 
and yes, it is a business. She 
brings her legendary skills such 
as front desk management, 
accounts receivables, collections, 
insurance billing, and treatment 
coordination. She offers detailed 
reports meant to steer any 
practice in the right direction 
by coaching doctors, front desk 
members, office managers, 
financial coordinators, and 
treatment coordinators on how 
to run and analyze weekly and 
monthly reports.

Cathy Jugovic

Contact Info: 

954.383.3566 
jugovicconsulting.com 

How Orthodontists Can Maximize 
Productivity During Downtime

Jeff Behan is a consumer 
marketing specialist, consultant, 
and accomplished filmmaker. 
He is a fun and relevant speaker 
whose subject matter focuses on 
internal/external communication, 
connecting with existing and 
prospective patients, referral-
building, and practice branding. 
He is the principal member of 
VisionTrust Communications, 
a company known for custom 
marketing solutions that serves 
over 1,000 orthodontic practices 
around the world. Jeff is also Co-
Founder and Creative Director of 
Orthodontic Revolution, and Co-
Founder and CEO of VisionTrust 
International.

Jeff Behan

Contact Info: 

jeff@orthodonticrevolution.com 
orthodonticrevolution.com

The Hidden Cost of Chasing  
ROAS in Orthodontics

A s summer approaches, 

some orthodontic 

practices experience a 

noticeable slowdown in patient 

visits. Families take vacations, 

children are out of school, and 

the balance of everyday life 

shifts, often resulting in lighter 

appointment schedules for 

orthodontists. While the summer 

months may present a challenge 

for maintaining consistent patient 

flow, they also provide a unique 

opportunity for orthodontic 

teams to address pending 

reports, refine their processes, 

and prepare for the busy months 

ahead.

Understanding the 
Slowdown
The summer months are 

traditionally a quieter time for 

orthodontists. With many families 

focused on travel and outdoor 

activities, routine orthodontic 

appointments often take a back 

seat. However, this seasonal 

lull does not have to equate 

to lost productivity. Instead, it 

offers a chance for orthodontists 

and their team to engage in 

administrative tasks that can 

enhance practice efficiency and 

patient care.

Maximizing Downtime  
Working With Key 
Reports

One of the most productive ways 

to utilize slower months is to 

tackle the backlog of pending 

reports. Orthodontic practices 

regularly generate reports such 

as Will Call Back or Pending 

reports, OBS reports, and 

Recall reports. Though these 

documents may seem tedious, 

they are integral to the smooth 

operation of a practice.

1.	 Will Call Back or Pending 

Reports: These reports 

track patients who have 

expressed interest in making 

appointments but have not 

yet returned for an actual 

visit. Summer is a perfect 

time to reach out to these 

patients. The relaxed pace 

allows orthodontists to 

personally connect with 

potential clients, reminding 

them of the benefits of 

starting treatment. A friendly 

follow-up can reinvigorate 

interest and ultimately bring 

more patients into the office.

2.	 Recall Reports: Keeping 

track of patients who 

are due for check-ups is 

essential for maintaining 

ongoing treatment plans. 

With fewer appointments in 

the schedule, orthodontists 

can focus on strategizing 

how to bring these patients 

Productivity continued on page 11

T here’s a pattern I see play out every single year in orthodontic 

marketing. A practice hires a digital agency to build their website 

and generate growth through Google Ads, Meta campaigns, special-

offer landing pages, and limited-time promotions. At first, the results 

can be exciting. Leads increase, phones ring, consult numbers go up, 

and the ROAS—Return on Ad Spend—looks like a real win.

Then it just stops working.

The cost per lead rises. Lead quality becomes less consistent. 

Conversion gets harder. And the practice finds itself spending more 

money trying to recreate results that once came easily.

When this happens, it’s easy to assume the ads stopped working or 

the strategy simply needs adjusting. But in many cases, the issue runs 

deeper.

ROAS is useful for measuring campaign performance, comparing 

media effectiveness, and tracking response. But ROAS has limitations, 

especially when it becomes the primary lens through which a practice 

evaluates marketing. ROAS measures immediate response. It does not 

measure trust, reputation, brand strength, patient experience, or long-

term preference in the marketplace.

And that distinction matters.

Think of it this way…a successful going-out-of-business sale works 

because the business has already accumulated value in the market. 

Over time, it has built awareness, credibility, reputation, and customer 

trust. The sale creates urgency around that existing value, and people 

respond. But the sale works precisely because the brand has equity to 

spend.

That same dynamic can happen in orthodontic advertising.

Direct-response ads—or what I like to call urgency ads—draw against 

the stored value of the brand. When used occasionally, they can 

be incredibly effective. They create excitement and give patients a 

reason to act now instead of later. But when urgency becomes the 

ongoing strategy, when the market is constantly presented with offers, 

promotions, or deadlines, it can erode the very brand value that made 

the ads work in the first place.

ROAS continued on page 10
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O n July 4, 2025, the One Big Beautiful Bill Act was 

signed into law. Among the provisions that received 

significantly less coverage than the headline tax measures 

was a fundamental restructuring of federal graduate and 

professional student lending, a restructuring that becomes 

effective July 1, 2026, and that will materially reshape the 

economics of the orthodontic pipeline for the next decade.

For an industry already navigating PE-backed consolidation, 

private credit stress, and generational shifts in practice 

ownership, this is a headwind that hasn’t been adequately 

priced into anyone’s strategic planning.

What the OBBBA actually does and the three provisions 

that matter for our industry:

First, the Graduate PLUS loan program will be eliminated 

for new borrowers starting July 1, 2026.  For more than a 

decade, Graduate PLUS has been the financing mechanism 

of last resort for dental and medical students, allowing 

borrowers to cover up to the full cost of attendance for 

graduate and professional programs.  After July 1 of this 

year, that door closes for new entrants.

Second, new aggregate borrowing caps apply to 

graduate and professional students who still qualify for 

federal lending. For students in designated “professional 

programs” like dentistry, medicine, and veterinary 

medicine, the annual direct unsubsidized loan limit rises to 

$50,000. The catch is the lifetime aggregate, which is fixed 

at $200,000.

Third, a new income-driven repayment plan replaces the 

previous menu of options. The Repayment Assistance Plan 

(RAP) will eliminate PAYE, SAVE, ICR, and other existing 

income-driven plans for new loans disbursed after July 1, 

2026.  RAP runs on a 30-year term with payments ranging 

from 1% to 10% of adjusted gross income, depending on 

income level. 

For high-debt borrowers, which describes virtually every 

dental specialty graduate, the new standard repayment 

plan produces unaffordable monthly payments, making RAP 

effectively the only practical option. The plan does include 

borrower-favorable provisions: negative amortization is 

eliminated (unpaid interest is subsidized rather than added 

to principal), and married borrowers filing separately can 

exclude spousal income from the payment calculation. 

But the 30-year term is significantly longer than the previous 

IDR plans, meaning a 28-year-old orthodontist beginning 

repayment in 2029 will be making payments until age 58.

The Squeeze on Current Residents
Most orthodontic residency programs run 24 to 36 months. 

Residents who began their programs in 2024 should be 

grandfathered into the Grad PLUS legacy provisions for the 

remainder of their residency. Residents starting in July 2026, 

however, will not have Grad PLUS access at all, and the 

$50,000 annual cap, with a $200,000 lifetime aggregate, will 

not come close to financing the full cost of an orthodontic 

residency on top of pre-existing dental school debt.

For perspective, the average dental school graduate debt 

currently sits at around $312,000. The American Association 

of Orthodontists reports that the average orthodontic 

resident graduates with approximately $567,000 in total 

student loan debt, which is among the highest debt loads 

in healthcare. The $200,000 lifetime professional cap covers 

roughly 35% of typical orthodontic graduate debt.  For 

residents already mid-program, the legacy provisions create 

real complexity.

The AAO has been advocating aggressively in Washington 

on this issue, but the legislation is law. The practical 

question now is how our orthodontic profession adapts.

The Pipeline Impact: Fewer Residents, 
Different Residents
Dental students considering orthodontic residency face 

a deceptively simple math problem. The cost differential 

between general dentistry and orthodontic specialization 

is significant, with three additional years of expensive 

education, often financed at high interest rates, with 

typically no income during training. Historically, Grad PLUS 

made that math workable, because students could borrow 

the full cost of attendance and amortize repayment against 

the higher specialty earning potential post-graduation.

Shannon Patterson, CPR, CMSR, Certified Kolbe Consultant, is 
a Partner with Bentson Copple Patterson & Associates and is a 
leading consultant in the orthodontic industry. She specializes in 
doctor placement and doctor retention with orthodontic practices 
throughout the United States.  

Shannon Patterson

Contact Info: shannon@bentsoncopple.com 
bcp-advisors.com

Under the new framework, that arithmetic shifts. A dental 

student facing a $200,000 federal lifetime cap, who has 

already borrowed against that cap for dental school, has 

effectively no federal borrowing capacity remaining for 

residency. The gap, which can easily exceed $200,000 to 

$300,000 for three years of orthodontic training, including 

living costs, has to come 

from private lenders or 

from family resources. 

Compounding the problem 

is that many of our 

orthodontic programs are 

located in high-cost-of-living 

areas. 

This creates two predictable 

patterns. First, residency 

pursuit will skew toward 

students whose families 

can finance the gap that 

federal lending no longer 

fills.  Specialty access, 

which federal lending has democratized for first-generation 

professionals and students from lower-income backgrounds, 

will narrow back towards the demographic that can self-

finance.

Second, total residency applications will decline 

meaningfully, particularly among students who would have 

been at the financial margin under the old system. Fewer 

residents will mean fewer new orthodontists entering 

practice in 2029 and beyond, which is exactly when the 

demographic wave of “Boomer Orthodontist” retirement 

will peak.

This shortage will interact with the PE consolidation 

dynamics already reshaping 

the industry. With fewer 

specialists available, DSO 

and OSO platforms will 

face increasing pressure on 

associate recruitment and 

retention. The compensation 

packages required to attract 

and retain specialists will rise. 

The economics of associate-

to-partnership pathways will 

tighten. The buy-in math that 

is already strained in a soft 

consumer environment will 

become even more challenging. 

The Private Lender Vacuum
The private student loan market is not a substitute for 

federal lending; it is a fundamentally different product. 

Private loans are credit-underwritten and almost always 

require a co-signer for residents without independent 

income. Interest rates are typically variable and several 

hundred basis points above federal rates. And the borrower 

protections that have made high-debt professional financing 

Pipeline continued on page 12

How Federal 
Loan Caps Will 
Reshape the 
Orthodontic 
Pipeline “ The associate market 

will contract as fewer 
new orthodontists enter 
the profession each year 
and as residency pursuit 
declines. The orthodontists 
who graduate will carry 
significant student debt 
loads that constrain their 
ability to absorb practice 
acquisition debt on top. ”
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ROAS continued from page 7

Over time, people stop responding to the practice itself and 

begin responding only to the offer. The relationship shifts. 

Instead of “This is the orthodontic office I trust,” the mindset 

becomes, “Let me know when they run the next special.”

That’s an expensive shift because eventually the offer starts 

carrying the weight the brand used to carry.

This is why some orthodontic ad campaigns perform 

exceptionally well in the first year and then become 

increasingly difficult to sustain. It isn’t that the ads got 

worse. It’s that the brand underneath them has been 

weakened by over-reliance on urgency-based marketing.

To be clear, I’m not against promotional advertising. We use 

it ourselves. In fact, I think it can be highly effective when 

used strategically. A summer campaign, an end-of-year 

insurance push, or a seasonal treatment-start promotion can 

create urgency and help move people to action. But in our 

view, that kind of advertising should be used sparingly, three 

or four times a year, as part of a broader strategy, not as the 

strategy itself.

My take has always been simple: brand and relationship 

marketing first. Urgency advertising used sparingly. It’s 

the same approach used by luxury brands such as Mercedes-

Benz and Lexus. They don’t avoid discounts or special 

incentives, but they do limit those promotional events to a 

handful of seasonal campaigns each year, carefully avoiding 

anything that might dilute the long-term value of the brand.

Sustainable orthodontic growth is built through reputation, 

referrals, community presence, and patient experience. It’s 

built through strong relationships with referring dentists, 

a memorable brand, a team culture patients want to talk 

about, and a consistent presence in the community. It’s built 

by becoming known before someone is ready to schedule, 

so that when the time comes, your practice is already the 

obvious choice.

When that foundation is in place, urgency advertising 

actually becomes more effective. It acts as an accelerator 

rather than a crutch. It supports momentum rather than 

creating temporary spikes that are difficult to maintain.

ROAS matters. Leads matter. Consults matter. Starts matter.

But the better question for any practice evaluating its 

marketing may be this:

Is what we are building sustainable over time?

Because the healthiest practices are not built on urgency. 

They’re built on brand. They’re built on relationships. And 

they’re built on becoming the practice people think of first 

and recommend without being asked.

That kind of growth takes a little longer to build. But it helps 

you actually build something that lasts. 

Free Cutting Edge Webinar Series

The Cutting Edge Webinar Series features industry-leading 
consultants and doctors presenting on their expertise in the 
field. These webinars are free and for anyone - from resident to 
experienced doctors and staff. 
 

Scan the QR code for a full calendar of 
webinars and recordings. Webinar recordings 
can be found at the bottom of the page and 
will be available for three months after the 
webinar takes place.

Productivity continued from page 6

back into the office. Sending 

personalized reminder letters or 

making phone calls to reconnect 

with patients is a productive way 

to ensure that the practice remains 

engaged with its client base.

Streamlining 
Administrative Processes
In addition to addressing these 

reports, summer downtime is a 

prime opportunity for orthodontists 

to streamline their administrative 

processes. This could include updating 

software systems, revising patient 

intake forms, or conducting team 

training aimed at enhancing patient 

communication. By investing time in 

improving internal systems, practices 

can create a more efficient workflow, 

ultimately benefiting patient care 

during busier months.

Moreover, orthodontists can encourage 

team members to participate in 

continuous education. Attending 

webinars or local conferences focused 

on the latest advancements in 

orthodontics will empower the team 

with fresh knowledge and cutting-edge 

techniques, enhancing service delivery 

when patient visits increase again.

Implementing Marketing 
Strategies
The slow summer months can also 

serve as a prime time for orthodontic 

practices to refine their marketing 

strategies. By developing targeted 

campaigns that emphasize the benefits 

of beginning orthodontic treatment 

over the summer, practices can work 

to fill their appointments in advance. 

Promotions for family packages or 

summer specials can entice parents to 

bring their children in for consultations, 

ultimately resulting in an uptick in 

patient numbers.

Social media platforms can play 

a crucial role during this period 

as well. Posts showcasing smile 

transformations, patient testimonials, 

and educational content about 

orthodontic benefits can engage 

existing patients while attracting new 

ones. A well-curated online presence 

keeps the practice visible and relevant, 

fostering a sense of community that 

can translate to real-world visits.

While it’s common for some 

orthodontic practices to experience 

slower months during the summer, 

it’s essential to view this period as an 

opportunity rather than a setback. 

By focusing on pending reports, 

streamlining administrative processes, 

and implementing proactive marketing 

strategies, orthodontists can not only 

maximize their productivity but also 

position their practices for success 

in the months ahead. Embracing this 

downtime can lead to improved patient 

care, heightened team morale, and a 

stronger foundation for future growth. 

So, as summer rolls in, let’s take a 

moment to prepare for the upcoming 

challenges, ensuring that our practices 

thrive year-round. 

SAVE THE DATE
Power Up 2027

March 4-6, 2027
Caesars Palace

Las Vegas
This highly anticipated event will bring together Ortho2 users, industry leaders, and 
Ortho2 experts for an experience designed to elevate, connect, and power up your 

practice.

Registration opens Fall 2026.
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manageable, like income-driven repayment and deferment 

and forbearance flexibility, will not exist in the private market 

in any meaningful form.

The market that fills the gap will attract two categories of 

lenders. The first is established players like Sallie Mae, SoFi, 

Earnest, and bank-affiliated student lenders who will expand 

professional student offerings to capture the demand. 

The second is more concerning: specialty and subprime 

lenders who target professional students with high-interest 

products and aggressive collection practices, betting on the 

high earning potential of dentists and specialists to make the 

credit risk pencil out.

Dental and orthodontic residents are particularly attractive 

targets for predatory lending precisely because of their 

expected post-graduation earnings. The AAO and ADA 

need to be vocal in protecting students from these 

arrangements, but the regulatory environment for private 

student lending has historically been weak, and the financial 

pressure on residents starting in 2026 will be intense.

What This Means for the Industry
For orthodontic practice owners, three implications deserve 

strategic planning attention.

First, the associate market will tighten. Practices that 

depend on a reliable supply of associate orthodontists for 

growth, transitions, or partnership pathways should expect 

more competition and higher compensation requirements 

over the next five to ten years. Recruitment timelines need 

to extend, and offer structures need to sharpen.

Second, the financial pressure on early-career orthodontists 

will be more intense than at any point in the last three 

decades. Practice transition pathways that assume rapid 

associate-to-partner buy-ins need to be re-modeled. 

Younger orthodontists will be more reluctant to take on 

practice acquisition debt on top of historic student debt, 

and the partnership math has to give them a credible path 

forward.

Third, the AAO’s advocacy work on this issue matters 

more than it has ever mattered. State-level loan repayment 

programs, federal interest deferral during residency, 

and broader specialty financing reforms are not abstract 

policy debates; they are the difference between a healthy 

orthodontic specialty in 2035 and a profession increasingly 

accessible only to those with family means.

The OBBBA is now law. The question facing the orthodontic 

profession is whether we adapt thoughtfully or watch our 

pipeline narrow.

The Transition Planning Dimension
If you own an orthodontic practice, the OBBBA’s student 

loan changes don’t affect you directly. They affect the 

people you need to hire, partner with, and eventually sell to, 

which means the disruption will show up in your transition 

economics, not your operating economics, and it shows up 

on a timeline most practice owners haven’t planned for.

The associate market will contract as fewer new 

orthodontists enter the profession each year and as 

residency pursuit declines. The orthodontists who graduate 

will carry significant student debt loads that constrain their 

ability to absorb practice acquisition debt on top.

Practices that adapt their transition planning to the new 

associate financing environment will have options. Practices 

that don’t will find themselves selling to whoever shows up 

with capital, on terms shaped more by the buyer’s leverage 

than the seller’s preference.

The next decade of orthodontic practice transitions will be 

more competitive on the buyer side than any decade in 

recent memory. The practice owners who win are going to 

be the ones who start planning while they still have time to 

be strategic. 

Pipeline continued from page 9

How to Get Edge Mobile:

Install Edge Mobile from the Play Store or iOS App Store. Once 
downloaded, enter your Customer Identifier in Edge Mobile settings. 
To find this number, in Edge Cloud click on the File Button, then click 
About. Next to the Customer Identifier is an Envelope icon. If you have 
Outlook installed, click the envelope next to the Customer Identifier to 
email the Customer Identifier to an email account your mobile device 
can access. We recommend using copy and paste to email the Customer 
Identifier to yourself if you do not have Outlook installed.

Exit Edge Mobile settings by clicking the back button in the top left 
corner. Then, log in with your Edge Cloud operator email and password. 
Your Edge Cloud operator record must have this email address associated 
with it, and you must use a password that is not blank.

Take Edge Cloud Anywhere With Edge Mobile

Referrals continued on next page

You can earn a $500 credit for each referral that results in an Ortho2 system purchase 
within six months. You can apply the credit toward any current or future charge or 
purchase — it never expires. We frequently hear from doctors that they wish we had 
contacted them before they purchased their current system. We wish we had too, but 
we didn’t know they were looking. You can help us help your colleagues by letting us 
know when they are considering a change in systems. Enter referrals online at www.
ortho2.com > Our Company > Referral Rewards, or call 800.678.4644. 

Referral Rewards

Do you need to call in to our Support Team for a question, but it’s difficult to wait on hold, 
even for a few minutes? Ortho2 has you covered! Use our chat support to get in contact with 
us. When you use the chat support feature, you will be added to the same queue as phone 
calls. You can choose to chat with the Software Support, New Customer Care, or Network 
Engineering Teams. 

In Edge Cloud, you can find links to chat support through the Help menu. In ViewPoint, click 
the Help button in the bottom right of the Daily Activities menu.

Chat Support
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Thirty-Six Years
Ken Hoffmeier 

Craig Scholz

Thirty-Four Years
Kim Barker

Thirty-One Years
Clarence Bryan

Twenty-Five Years
Ron Benifiel 

Cathie Morton

Twenty-Four Years
Barb Williams

Twenty-Two Years
Micky Augustin

Twenty Years
Lindsey Spieker

Fifteen Years
Sean Gildersleeve 

Michelle Haupt 

Jess Huennekens

Fourteen Years
Elizabeth Nordeen

Twelve Years
Michael Lasley 

Gabrielle Schaaf

Ten Years
Brooke Hawke

Nine Years
Joe Skluzacek

Eight Years
Isaiah Austin 

Sam Rubenstein

Six Years
Larry St. John

Five Years
Nicole Cook

Four Years
John Diercks 

Amanda Moore

Three Years
Aaron Sader

Two Years
Charla Webb 

Celebrating Ortho2 Anniversaries

Congratulations to these Ortho2 team members who celebrated anniversaries during the second quarter of 2026.

Looking for EDGEucational content to help you become an Edge Cloud guru? Our  
EDGEpisodes series is perfect for you! These bite-size videos will provide you with quick and 
easy tips to master all things Edge Cloud and are easily accessible on Facebook and Instagram.

EDGEucate Yourself With EDGEpisodes

By Phone: 800.346.4504

By Email: ortho2support@ortho2.com

And Don’t Forget Our Website:  
support.ortho2.com

Available 7:00 A.M. – 7:00 P.M. Central Time, Monday – Friday 

Response time is usually the same day or at most within 24 hours.

Our website gives you 24/7 access to our knowledge base, FAQs,  
white papers, visual help videos, and more.

Contact Support
Retraining

Have you hired new staff since your original software training? Have you 
had staff members take on new responsibilities? Do you feel you might not 
be taking advantage of the enhancements that have been added over the 
years?

Ortho2 offers many options for refreshing your knowledge of old features 
and informing you of new features, but do you want to be able to set your 
own agenda to meet the specific needs of your practice?

A retraining — either in your office or over the Internet — addresses all 
these issues. To learn more and to schedule one for your practice, contact 
your Ortho2 Regional Manager today at 800.678.4644 or sales@ortho2.com.

We invite you to recognize Ortho2 employees by submitting 
an Extra Mile form. The form is available online from the 
Contact Us page of our website. Our goal is to uphold our 
tradition of excellence in customer service, and with our Extra 
Mile program, you can let our employees know when you 
appreciate their extra effort. We encourage you to submit an 
Extra Mile form whenever an Ortho2 employee goes the extra 
mile for you. The recognition is valued by the recipient and 
is acknowledged by our management team. We continue to 
look for better ways to serve you. Thank you for helping us 
recognize excellence.

Service Excellence

Please be prepared to provide your customer number, practice name, and office location when you call our 
support teams for assistance. You can find your customer number in Edge Cloud by clicking File > About. If you 
use ViewPoint, you will find your customer number by clicking the Help menu and choosing About. Please be sure 
to provide this information—and repeat your phone number—when leaving a phone message requesting support. 

Help Us Help You
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